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Without the prior written consent of ZKTeco, no portion of this manual can be copied or forwarded in any
way or form. All parts of this manual belong to ZKTeco and its subsidiaries (hereinafter the "Company" or
"ZKTeco").

ZKT:co isa registered trademark of ZKTeco. Other trademarks involved in this manual are owned by
their respective owners.

This manual contains information on the operation and maintenance of the ZKTeco equipment. The
copyright in all the documents, drawings, etc. in relation to the ZKTeco supplied equipment vests in and is
the property of ZKTeco. The contents hereof should not be used or shared by the receiver with any third
party without express written permission of ZKTeco.

The contents of this manual must be read as a whole before starting the operation and maintenance of
the supplied equipment. If any of the content(s) of the manual seems unclear or incomplete, please
contact ZKTeco before starting the operation and maintenance of the said equipment.

It is an essential pre-requisite for the satisfactory operation and maintenance that the operating and
maintenance personnel are fully familiar with the design and that the said personnel have received
thorough training in operating and maintaining the machine/unit/equipment. It is further essential for
the safe operation of the machine/unit/equipment that personnel has read, understood and followed the
safety instructions contained in the manual.

In case of any conflict between terms and conditions of this manual and the contract specifications,
drawings, instruction sheets or any other contract-related documents, the contract
conditions/documents shall prevail. The contract specific conditions/documents shall apply in priority.

ZKTeco offers no warranty, guarantee or representation regarding the completeness of any information
contained in this manual or any of the amendments made thereto. ZKTeco does not extend the warranty
of any kind, including, without limitation, any warranty of design, merchantability or fitness for a
particular purpose.

ZKTeco does not assume responsibility for any errors or omissions in the information or documents which
are referenced by or linked to this manual. The entire risk as to the results and performance obtained from
using the information is assumed by the user.

ZKTeco in no event shall be liable to the user or any third party for any incidental, consequential, indirect,
special, or exemplary damages, including, without limitation, loss of business, loss of profits, business
interruption, loss of business information or any pecuniary loss, arising out of, in connection with, or
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relating to the use of the information contained in or referenced by this manual, even if ZKTeco has been
advised of the possibility of such damages.

This manual and the information contained therein may include technical, other inaccuracies or
typographical errors. ZKTeco periodically changes the information herein which will be incorporated into
new additions/amendments to the manual. ZKTeco reserves the right to add, delete, amend or modify the
information contained in the manual from time to time in the form of circulars, letters, notes, etc. for
better operation and safety of the machine/unit/equipment. The said additions or amendments are
meant for improvement /better operations of the machine/unit/equipment and such amendments shall
not give any right to claim any compensation or damages under any circumstances.

ZKTeco shall in no way be responsible (i) in case the machine/unit/equipment malfunctions due to any
non-compliance of the instructions contained in this manual (i) in case of operation of the
machine/unit/equipment beyond the rate limits (iii) in case of operation of the machine and equipment in
conditions different from the prescribed conditions of the manual.

The product will be updated from time to time without prior notice. The latest operation procedures and
relevant documents are available on http://www.zkteco.com

If there is any issue related to the product, please contact us.

ZKTeco Industrial Park, No. 26, 188 Industrial Road,
Tangxia Town, Dongguan, China.

+86 769 - 82109991

+86 755 - 89602394

For business-related queries, please write to us at sales@zkteco.com.

To know more about our global branches, visit www.zkteco.com.
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ZKTeco is one of the world’s largest manufacturer of RFID and Biometric (Fingerprint, Facial, Finger-vein)
readers. Product offerings include Access Control readers and panels, Near & Far-range Facial Recognition
Cameras, Elevator/floor access controllers, Turnstiles, License Plate Recognition (LPR) gate controllers and
Consumer products including battery-operated fingerprint and face-reader Door Locks. Our security
solutions are multi-lingual and localized in over 18 different languages. At the ZKTeco state-of-the-art
700,000 square foot I1SO9001-certified manufacturing facility, we control manufacturing, product design,
component assembly, and logistics/shipping, all under one roof.

The founders of ZKTeco have been determined for independent research and development of biometric
verification procedures and the productization of biometric verification SDK, which was initially widely
applied in PC security and identity authentication fields. With the continuous enhancement of the
development and plenty of market applications, the team has gradually constructed an identity
authentication ecosystem and smart security ecosystem, which are based on biometric verification
techniques. With years of experience in the industrialization of biometric verifications, ZKTeco was
officially established in 2007 and now has been one of the globally leading enterprises in the biometric
verification industry owning various patents and being selected as the National High-tech Enterprise for 6
consecutive years. Its products are protected by intellectual property rights.

This manual introduces the operations of the C2-260/inBio2-260 Access Control Panel.

All figures displayed are for illustration purposes only. Figures in this manual may not be exactly
consistent with the actual products.
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Document Conventions

Conventions used in this manual are listed below:

GUI Conventions

For Software ‘

Convention Description
Bold font Used to identify software interface names e.g. OK, Confirm, Cancel
S Multi-level menus are separated by these brackets. For example, File > Create >
Folder.
Convention Description
<> Button or key names for devices. For example, press <OK>
[ Window names, menu items, data table, and field names are inside square
brackets. For example, pop up the [New User] window
/ Multi-level menus are separated by forwarding slashes. For example,
[File/Create/Folder].

Symbols
Convention Description

| This implies about the notice or pays attention to, in the manual
: The general information which helps in performing the operations faster

3{;2 The information which is significant

@ Care taken to avoid danger or mistakes
f The statement or event that warns of something or that serves as a cautionary

example.
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Safety Instructions

Important Security Instructions

Read and follow the instructions carefully before operation. Please keep the instructions for future
reference.

Accessories: Please use the accessories recommended by the manufacturer or delivered with the
product. Other accessories are not recommended, including major alarming systems and
monitoring systems. The primary alarming and monitoring system should comply with the local
applicable fire-prevention and security standards.

Installation cautions: Do not place this equipment on an unstable table, tripod mount, support, or
base, lest the equipment falls and get damaged or any other undesirable outcome resulting in
severe personal injuries. Therefore, it is essential to install the equipment as instructed by the
manufacturer.

All peripheral devices must be grounded.

No external connection wires can be exposed. All the connections and idle wire ends must be
wrapped with insulating tapes to prevent any damage to the equipment by accidental contact of
the exposed wires.

Repair: Do not attempt to have an unauthorized repair of the equipment. Disassembly or
detachment is risky and likely to cause shock. All repairs should be done by a qualified technician.

If any of the following cases arise, disconnect the power supply from the equipment first and
intimate the technician immediately.

The power cord or connector is damaged.
Any liquid or material spilled into the equipment.
The equipment is wet or exposed to bad weather (rain, snow, etc.).

If the equipment cannot work properly, even if it is operated as instructed, please be sure to adjust
only the control components specified in the operating instructions. Incorrect adjustments on
other control components may cause damage to the equipment; even the equipment may fail to
operate permanently.

The equipment falls, or its performance changes dramatically.

Replacing components: If it is necessary to replace a component, only the authorized technician
can replace the accessories specified by the manufacturer.

Security inspection: After the equipment is repaired, the technician must conduct security
inspection to ensure proper working of the equipment.
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Power supply: Operate the equipment with only the type of power supply indicated on the label.
Contact the technician for any uncertainty about the type of power supply.

~

e
O Violation of any of the following cautions is likely to result in personal injury or equipment
I failure. We will not be responsible for the damages or injuries caused thereby.

Before installation, switch off the external circuit (that supplies power to the system), including
locks.

* Before connecting the equipment to the power supply, ensure the output voltage is within the
specified range.

K' Never connect the power before completion of installation. /

Installation Instructions

The conduits of wires under relay must match with the metal conduits; other wires can use PVC
conduits, to prevent failure caused by rodent damage. The Control panel is designed with proper
antistatic, lightning-proof, and leakage-proof functions, ensure its chassis and the AC ground wire
are correctly connected and the AC ground wire is grounded physically.

It is recommended not to plug/unplug connection terminals frequently when the system is
powered on. Be sure to unplug the connection terminals before starting any relevant welding job.

Do not detach or replace any control panel chip without permission, and an unpermitted
operation may cause damage to the control panel.

It is recommended not to connect any other auxiliary devices without permission. All non-routine
operations must be communicated to our engineers in advance.

A control panel should not share the same power socket with any other large-current device.

It is preferable to install card readers and buttons at the height of 1.4 to 1.5m above the ground
or subject to customers’ usual practice for proper adjustment.

It is advised to install control panels at places where maintenance is easy, like a weak electric
well.

It is strongly recommended that the exposed part of any connection terminal should not be
longer than 4mm, and specialized clamping tools may be used to avoid short-circuit or
communication failure resulting from accidental contact with excessively exposed wires.

To save access control event records, export the data periodically from control panels.

Prepare countermeasures according to application scenarios for unexpected power failure, like
selecting power supply with UPS.

If RS485 reader is connected externally and shared the power supply with the device (The control
panel does not support fingerprint verification of RS485 reader), it is recommended that the
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connection between the RS485 reader port and the reader be no longer than 100m. Otherwise, it
is recommended that the reader use a separate power supply.

To protect the access control system against the self-induced electromotive force generated by an
electronic lock at the instant of switching off/on, it is necessary to connect a diode in parallel
(please use the FR107 delivered with the system) with the electronic lock to release the
self-induced electromotive force during onsite connection for application of the access control
system.

It is recommended that an electronic lock and a control panel should use separate power supplies.

It is recommended to use the power supply delivered with the system as the control panel power
supply.

In a place with substantial magnetic interference, galvanized steel pipes or shielded cables are
recommended, and proper grounding is required.
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System Introduction

The Access Control management system is a new modernized security management system, which is an
effective measure of security and protection management. It is mainly used to manage the entrances and
exits of highly secured places, such as banks, hotels, equipment rooms, offices, smart communities, and
factories.

System Functional Parameters

High-speed 32-bit 1.0GHz CPU and 64M RAM.

Embedded LINUX operating system.

Two-door one-way/two-way.

User capacity: 30,000.

A maximum of 30,000 cardholders.

Fingerprint capacity: 2,000 (inBio2-260).

200,000 offline event records.

Use Ethernet communication technologies for reliable communications.
Control Panel with a watchdog (hardware) built in to prevent a crash.
Over-current, over-voltage, and inverse-voltage protection for the input of the power supply to
the control panel.

Over-current protection for the power supply to card readers.

Instant over-voltage protection for all input/output ports.

Instant over-voltage protection for communication ports.

Product Technical Parameters

Working Power supply: Rated voltage 12V (£20%) DC, rated current is > 3A

Working environment: Temperature -10°C to 50°C; Humidity 20% to 80%.

Electronic lock relay output: The maximum switching voltage is 36V(DC); The maximum switching
current is 5A.

Auxiliary relay output: The maximum switching voltage is 36V(DC); The maximum switching
current is 2A.

The detachable connection terminals are made of alloy-steel non-magnetic flange materials.
Control panel dimensions: 116.5mm*96.5mm*31.3mm

Control Panel Indicators

When the C2-260/inBio2-260 is powered on, normally the POWER indicator (red) is lit constantly, the RUN
indicator (green) shall flash slowly (indicating the system is normal), and other indicators are all off.

COMM indicator (yellow): It flashes when the system is communicating with other devices (e.g., PC). When
the indicator is flashing continuously, it indicates data transmission. When the indicator is flashing slowly,
it indicates real-time monitoring status.
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Indicator Diagram:
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Installation and Connection

Installation Procedure

The following describes the rail installation process.

\\\\ @ (1)
= e o
< g

1) Fix the guide rail on the wall 2) Fix the device to the guide rail.

The following describes the wall installation process.

1) Drill holes on the wall 2) Fix the device with four screws
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Installation of Access Control Panel Wires

_ = — — 2
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TCP/IP Network communication wire RS485 Network communication wire
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Access Control Panel Wire Installation Diagram
Remarks:

Ensure the power supply is disconnected before connecting the wires; otherwise, it may cause
severe damage to the equipment.

The access control wires must be separated according to heavy and light current; the control
panel wires, electronic lock wires, and exit button wires must run through their casing pipes,
respectively.
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Control Panel System Installation
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Schematic Diagram of System Installation

The access control management system consists of two parts: Management Workstation (PC) and Control
panel. The management workstation and control panel communicate through TCP/IP and R5485 network.
The communication wires should be kept away from high-voltage wires as far as possible and should be
neither routed in parallel with nor bundled with power wires.

A management workstation is a PC connected with the network. By running the access control
management software installed in the PC, access control management personnel can remotely perform
various management functions, like adding/deleting a user, viewing event records, opening/closing doors,
and monitoring the status of each door in real-time.
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Control Panel Connection Terminals

C2-260/inBio2-260 Terminal connection diagram

Auxiliary  Auxiliary

#1 Door #2 Door Output Input
A | | A
[ | | f L |
7 3\
= = = - E - v 28 Z o B
O v $g362 2888352 282888 282 O
LOCK1 LOCK2 AUX OUT AUX IN
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R5485 DIP
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Description of the terminals:

The auxiliary input may connect to infrared body detectors, fire alarms, or smoke detectors.
The auxiliary output may connect to alarms, cameras or doorbells, etc.

PC RS485 indicates the RS485 cable is connected to the DM10/AUX485 through this port. The
RS485 Reader port can be connected externally to RS485 reader. Note: Only inBio2-260 supports to
connect the FR1200 readers.

Restore factory setting: The NO.4 of DIP switch is OFF by default. When it is moved up and down
for three times within 5 seconds and finally returned to ON position, the factory settings will be
restored after the access control panel is restarted, and the IP address will restore to the default
(192.168.1.201).
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5. The terminals above are set through the relevant access control software. Please see the respective
software manual for further details.

Ports of C2-260/inBio2-260 Control Panel:

Functional Port Seeet jnSioaiees
(Two-Door Two-Way) (Two-Door Two-Way)
1 Exit button 2 2
2 Control lock relay 2 2
3 Door Sensor 2 2
4 Auxiliary Input 2 2
5 Auxiliary Output 2 2
6 RS485 Reader 4 4
7 FR1200 Reader 0 4
8 RS485 Extension v v

Communication

9 TCP/IP v v

3.5 Connection with Door Sensors, Exit Switches, Auxiliary
Input Devices, and RS485 Extension Communication

1. Door sensor

A Door Sensor is used to sense the open/close status of a door. With a door sensor switch, an access
control panel can detect the unauthorized opening of a door and will trigger the output of alarm.
Moreover, if a door is not closed within a specified period after it is opened, the door control panel will
also raise the alarm. It is recommended to select two-core wires with a gauge over 0.22 mm?. A door
sensor can be omitted if it is unnecessary to monitor the open/closed status of a door, raise the alarm
when the door is not closed for a long time, monitor if there is unauthorized access, and use the interlock
function.
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Exit switch

An exit switch is a switch installed indoor to open a door. When it is switched on, the door will be opened.
An exit button is fixed at the height of about 1.4m above the ground. Ensure it is located in the right
position without slant, and its connection is correct and secure. (Cut off the exposed end of any unused
wire and wrap it with insulating tape.) Make sure to avoid electromagnetic interference (such as light
switches and computers). It is recommended to use two-core wires with a gauge over 0.3mm?as the

connection wire between an exit switch and the Control panel.

Auxiliary input

The control panel provides one auxiliary input interface which may connect to infrared body detectors,
smoke detectors, gas detectors, window magnetic alarms, wireless exit switches, etc. Auxiliary inputs are
set through the relevant access control software. Please see the respective software manual for further

details.
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Connections between Control Panel and Door Sensors, Exit Switches and Auxiliary Input Devices

RS485 extension communication

The Control panel supports extensive modules which like DM10 and AUX485, through RS485. A
C2-260/inBio2-260 can connect eight DM10 at most or can connect two AUX485 at most. As shown in the

following figure.
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o= C2-260/ inBio2-260
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Connect with DM10 through RS485
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Connect with AUX485 through RS485

1. A C2-260/inBio2-260 can connect to maximum eight DM10 modules or two AUX485 modules.

2. Each AUX485 module can connect to maximum four auxiliary devices.

3. Each DM10/AUX485 module requires a separate power supply.
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Connection with RS485 Readers

The Control panel supports RS485 reader (Note: C2-260 supports RS485 Card Reader only, inBio2-260
supports both R5485 card and Fingerprint reader).

The Control panel supports four readers, which can be connected in the two-door two-way mode.

RS485 reader connection: Set the RS485 address (device number) of the reader by DIP switch or other
ways.

RS485 address

Control Panel

C2-260/inBio2-260 1Door IN 1Door OUT | 2DoorIN | 2Door OUT

PC

= (€2-260/inBi02-260
-
0 a
TCP/IP |

4# Reader 3#Reader 2#Reader 1# Reader

The connection between the Control Panel and RS485 Card Readers

PC “}

e —— — -
= = inBio2-260

90 =

wr L

4#FR1200 3#FR1200 2#FR1200 1#FR1200

The connection between the Control Panel and Fingerprint Readers

Page |18 Copyright©2020 ZKTECO CO,, LTD.  All rights reserved.



(C2-260/inBio2-260 Access Control Panel User Manual

A single RS485 reader interface can supply a maximum of 750 mA (12V) current. So, the entire current
consumption should be less than this maximum value when the readers share power with the panel. For
calculation, please use the maximum current of the reader, and starting current is usually more than twice
the standard work current.

Using the KR502M-RS card reader as an example, the standby current is less than 80mA; the maximum
current is less than 90mA. When starting the device, the instantaneous current can reach 180 mA. For an
RS485 reader, considered that the starting current is large, only four readers can connect to the power
supply through the RS5485 reader interface. So, the power of the control panel can only connect up to 2
readers.

If RS485 reader is connected externally and shares the power supply with the device, it is recommended
that the connection between the RS485 reader port and the reader be no longer than 100m. Otherwise, it
is recommended to use a separate power supply for the reader.

For the devices which consume more power, we suggest using different power supplies to ensure
steady operation.

Relay Output Connection

C2-260/inBio2-260 has three relays (two used as control locks by default, and the other one used as
auxiliary outputs).

The relays for auxiliary outputs may connect to monitors, alarms, doorbells, etc. Auxiliary outputs are set
through the relevant access control software. Please refer to the respective software manual for details.

The default connection mode of the door lock is “dry mode.” In general, the electronic lock uses an
external power supply separately. The wiring mode of the door lock relay cannot be changed, except
that the auxiliary output relay. The diagram below uses the example of a door lock connection to
demonstrate the output relay connection.

An access control panel provides multiple electronic lock outputs. The COM and NO terminals apply
to the locks that are unlocked when power is connected and locked when power is disconnected.
The COM and NC terminals use the locks that are locked when power is connected and unlocked
when power is disconnected.

Our access control panel is powered by standard PoE or access control power. You can choose either
one of the power supplies as needed. Both two power supplies provide 12V/3A power for only the
power consumption of the control panel, Wiegand readers, and output power consumption of RS485
reader.

To protect the access control system against the self-induced electromotive force generated by an
electronic lock at the instant of switching off/on, it is necessary to connect a diode in parallel (please
use FR107 delivered with the system) with the electronic lock to release the self-induced
electromotive force during the onsite connection for application of the access control system.
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Wiring diagram of lock connection
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Equipment Communication

The background PC software can communicate with the system according to two protocols (TCP/IP and
RS485) for data exchange and remote management.

Access Control Networking Wires and Wiring

The power supply is 12V DC converted from 220V or PoE.

As an electronic lock has a large current, it generates a strong interference signal while functioning.
To reduce such an effect, 4-core wires (RVVP 4X0.75mm?, two for a power supply, and two for a
door sensor) are recommended.

“RS485” interface uses 4-core communication shielded wires (RVVSP 4*0.5mm).
Other control cables (like exit switches) are all made of 2-core wires (RVVSP 2 X 0.5mm?).
Notes for wiring:

Signal wires (like network cables) can neither run in parallel with nor share one casing pipe with
large-power electric wires (like electronic lock wires and power cables). If parallel wiring is
unavoidable for environmental reasons, the distance must be above 50cm.

Try to avoid using any conductor with a connector during distribution. When a connector is
indispensable, it must be crimped or welded. No mechanical force can be applied to the joint or
branch of conductors.

In a building, the distribution lines must be installed horizontally or vertically. They should be
protected in casing pipes (like plastic or iron water pipes, to be selected according to the
technical requirements of the indoor distribution). Metal hoses are applicable to ceiling wiring,
but they must be secure and good-looking.

Shielding measures and shielding connection: If the electromagnetic interference in the wiring
environment is found substantial in the survey before construction, it is necessary to consider
the shielding protection of data cables when designing a construction scheme. Overall,
shielding protection is required if there is a large radioactive interference source or wiring has to
be parallel with a large-current power supply on the construction site. Generally, shielding
measures includes keeping a maximum distance from any interference source, and using metal
wiring troughs or galvanized metal water pipes to ensure reliable grounding of the connection
between the shielding layers of data cables and the metal troughs or pipes. Noted that a
shielding enclosure can have a shielding effect only when it is grounded reliably.

Ground wire connection method: Reliable large-diameter ground wires in compliance with
applicable national standards are needed on the wiring site and should be connected in a tree
form to avoid DC loop. These ground wires must be kept far away from lightning fields. No
lightning conductor can serve as a ground wire and ensure there is no lightning current through
any ground wire when there is lightning. Metal wiring troughs and pipes must be connected
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continuously and reliably and linked to ground wires through large-diameter cables. The
impedance of this section of wire cannot exceed 2 ohms. Also, the shielding layer must be
connected reliably and grounded at one end to guarantee a uniform current direction. The
ground wire of the shielding layer must be connected through a large-diameter wire (not less
than 2.5mm?).

TCP/IP Communication

The Ethernet 10/100Base-T Crossover Cable, a type of crossover network cable, is mainly used for
cascading hubs and switches or used to connect two Ethernet endpoints directly (without a hub). Both
10Base-T and 100Base-T are supported.

| PC |_| é Printer
-6.——1_[ Card Issuer

TCP/IP [
YY)
o) B [N a la
1# Control Panel 2# Control Panel N# Control Panel

TCP/IP Communication System Networking

In Access software: Click Device > Search Device to search for access controllers in the network, and
directly add from the search result.

ZKPanelWeb

This built-in function is newly added to assist user to manage controllers more conveniently. Users can use
the Web Server function to perform operations, such as network configuration, push communication
configuration, time synchronization, and user account management.

Log on to the Web Server

Create a valid connection string using TCP/IP.

Input the IP address of the controller (factory default is 192.168.1.201) in the address bar; enter the user
name and password (both are admin), and click [Sign In] to access the ZKPanelWeb.
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ZK

User Login

Liser Name

Password

¥ sionn X  Cancel ‘

Note:

1. IP addresses of both the server (PC) and the controller must be in the same network segment.
2. IP address of the controller could be found by searching devices with the BioSecurity software
([Access] > [Access Device] > [Device] > [Search Device]).

® TCP/IP Settings

Click [TCP/IP Settings] to modify the IP address and gateway address.

(€)= ¢ @& | @ & 192168.1.201/main.htmi

@] TCP/IP Settings

Primary Metwork Card Setting
IP Address: | 192.168.1.201 I
SubnetMask:;§255_255.255.0 [*
ttings Gateway: | 192.168.1.254
Communication Password Primary DNS: 0.0.0.0

Time Settings

System Settings

Device Information

® Communication Settings

Set communication parameters in ZKPanelWeb and connect the controller to the server (PC); the controller
will automatically push information to the server.

1) Server Settings
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(— c @ © & 192.168.1.201/main.html

L_I_.l Network Settings [#8] Server Settings
. _ Mote:lf both the IP mode and the domain mode are available, the domain node is preferred.
TCP/IP Settings
Use mode settings @ Connectto BioSecurity () Connectto mian device
ommunication Settings
g BioSecurity Server Settings: @) IP Mode () Domain Mode
IP Address: | 192.168.222.5

Communication Password Port: 8088

Use mode settings: The default mode is Connect to BioSecurity.
BioSecurity Server Settings: To set the parameters of the IP Mode and Domain Mode.
IP Mode: The default server IP is 0.0.0.0, and you can modify it according to the practical situation.

Port: The default Port is 8088, and you can modify it according to the practical situation.

Server Settings
Mote:If both the IP mode and the domain mode are available, the domain node is preferred.
Usze mode seftings @ Connectto BioSecurity ) Connectto mian device
BioSecurity Server Settings: () IP Mode @ Domain Mode

Domain Mame: hitps:/iM92.168.222 51

Domain Mode: The default value is null, and you can set its value. If the user wants to login to the BioSecurity
software via HTTPS, then set the domain name here. The format is: https://192.168.222.5:8088.

2) Communication Password

(&« = O @ © & 192.168.1.201/main.html

Tzza

fI_l Network Settings @] Communication Password

: Old Password: l:l Enter a string of 0-6 characters!
TCP/P Settings |

Mew Password: | Enter a string of

6 characters!

ommunication Settings /s . .
Confirm Mew Password: | Enter a string of 0-6 characters!
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Communication Password: Indicates that network communication is encrypted. The default value is null,
and you can set its value.

If you configure the communication password here, the same communication password must be configured
on the server before the connection can be set up.

® System
The user can synchronize time to the computer, set up the system and view device information here.

1) Time Settings

(&)= ¢ @& © £ 192.168.1.201/main.html

FI_J. Network Settings j| Time Settings

1 CumentTime:: 2020-10-13 15:02:12
TCP/IP Settings |

Synchronization with Computer Time

2 ication Settings
ETETIR R PC Time: |2020-10-13 15:02:10

Communication Password

System

System Settings

Device Information

2) System Settings

€« = & @ © & 192.168.1.201/main.html

Tzca

fh Network Settings (@8] System Settings

Reboot Device: Reboot
TCP/IP Settings |

Restore Factory Setting: confirm

ommunication Settings

Server Settings

Communication Password

System

Time Settings

Device Information

Page |25 Copyright©2020 ZKTECO CO.,, LTD.  All rights reserved.



(C2-260/inBio2-260 Access Control Panel User Manual
3) Device Information
« =< C o @ & 192168.1.201/main htmi B e Y iInD © 8 & =

=] Device Information
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Device Nams,

Serizl Mumbar:

Platform:

Firmvware Version:

Maximum user count:

Iagimum log count:

MAD Adaress:

IP Address:
SBubnet Mask:
Cat=way:
Primary DNE:

TCF Port:

C2-Z60

5322183000012

ZLMG0_C2

AT Var9.0.2.0014 3ep 18 2020
30000 Remalning Capacty: 70000
200000

00A7611184ET

182,168 1.201

255,255 255.0

102 168 1264

0.0.0.0

4370

wekcomsonn @ 8 D @ O
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ZKBioAccess

The following sections explain the functions of ZKBioAccess software after the Access Controllers are
installed.

Login

User Login

After installing the software, double-click the ZKBio Access icon @ to open the software. You may also

open the recommended browser and enter the IP address and server port in the address bar. The IP
address is http://127.0.0.1:8098 by default.

If the software is not installed in your server, you may enter the IP address and server port in the address
bar.

& Note: The username of the superuser is admin, and the password is admin, then click Login. After
logging in for the first time, you need to reset your password.

Activate the System

Please refer to the corresponding license activation document.

Modify Password

You can modify the login password in the Personal Information section.

Welcome, admin

Click here to open modify interface
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Personal Information

Username® admin

etween 1-30 characters and

Usermname should be composed b

Reset Password [
Password® S
-

i " 3 - e

Password is 8 ':c\ = nf 4 to 18 characters,default is

1141711

: \\ Select the check
Confirm FPassword
box to reset

Superuser State o b o
Role I
Auth Department

17 you select no department, you will possess all depariment

rights by default.

Authorize Area
Ii you select no-area, you will possess all area righis by
default.

Email

First Name admin

Select the Reset Password checkbox to modify the password.

& Note: Both the Superuser and the new user are created by the Superuser (the default password for the
new users is 111111). The username is not case-insensitive, but the password is case-sensitive.

Device

The Device Settings adds an access device and then sets the communication parameters of the connected
devices, including system settings and device settings. When the communication is successful, you can
view here the information of the connected devices, and perform remote monitoring, uploading and
downloading, etc.
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Adding a Device

There are two ways to add Access Devices.

Add Device by Searching Access Controllers.

Search the Access Controllers in the Ethernet.

Devica Hame | | SenalNumbar | ] ‘Search Device

1
Thes current query conditions Nene : 4
; : R EEE - o= rouro” Ronninns Search Took o1 coal ik
(v Rewssh [# new [ Dolets [ Expot Q Sesreh Desic

Searched devices countd

- § Total Progress [ Numbar of devices addesd 4
Davice Nams Serial Number  AmaMams  Com gt i
BB p s Device Tyae Seral Numbar (]

97 1RRTANE CJHE132960010 Aras Name H'rr] P Address MAC Addresa Subnet Mask  Gateway Address  Serial Number Device Typs  Sel Server Opera
15216890 232 CRITIAIEO005 - Arsa Name: HPl 1521680108 10360 CJHB192550013  SmartACT This de
193 168 10 218 CUTS1S2460017 Area Name  HIT| 152168176 2550, 0.0.0.0 CJ74192960006  ProFace X This de
T CUT4132960006 Arsa Name H-rri 152 16610.219 192 16310 254 [ 4ED07  ProFace X|CF Thia de

152,186 10,232 192.168.10 254 CJI4183360005  SpesdFace-V This de

AT
Cloze

i m,‘ Tramge

Click Access > Device > Search Device to open the Search interface.
Click Search, and it will prompt Searching.......
After the search is complete, the list and the total number of access controllers will be displayed.

Mo device found? Dowmload Search Toaols fo Local Disk

Tota Progress | IO | ti:msor of devices adder
LR Mumber of devices added: 1

|P Address | Device Type Serial Mumber ®

IP Address MAC Address Subnet Mask Gateway Address Serial Mumber Device Type el Server Operations
192.168.1.201 2552552550 0.0.0.0 5264153100152  TDBO3 Add
192.168.213.67 2552552550 192.168.213.1 CGFE184760043 SpeedFace-V: This device has been added

A\ The current system communication port is 881, please make sure the device is set cormectly.
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&Note: UDP broadcast mode will be used to search the access devices. This mode cannot perform a
cross-router function. The IP address can provide a cross-net segment, but it must be in the same subnet,
and the Gateway and IP Address must be configured in the same network segment.

Click Add in the search list.

If the device is a pull device, you may enter a device name and click OK to complete adding the device.

Mew

Device Mame*

Communication Type® i@ TCPRIP

IP Address®

Communication port® 4370

Communication Password

lcon Type™ Doar

Control Panel Type One-Door Access Conl

Area* Area hame

Add to Level _

Clear Data in the Device when [l

Adding

A [Clear Data in the Device when Adding] will delete datain the device
[except event recard}, please use with caution!

Clear Data in the device when Adding: If this option is selected, after adding a device, the system will

clear all data in the device (except the event logs).

If the device is a push firmware device, the following windows will pop-up after clicking Add. If the IP
Address in New Server Address is selected, then configure the IP address and port number. If Domain
Address in New Server Address option is selected, then set the Domain address, port number, and DNS.

The device will be added to the software automatically.
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Add
Device Name* 192.168.213.155
New Server Address™® @IP Address ()Domain Address

192 . 168 .213 .25

New Server Port* 8088 [
Communication Password
Icon Type® Door |
Area® Area Name |
Add to Level _
Clear Data in the Device when Adding [}
A D e device (except eve

Mew
Device Mame®
Communication Type® @ TCPIP
IP Address®
Communication port® 4370
Communication Password
Icon Type® Door
Control Panel Type One-Door Access Coni
Area” Area Name
Add to Level _
Clear Data in the Device when 0o
Adding

Al

New Server Address: To add a device by IP Address or Domain Address, devices can be added to the
software by entering the domain address.

New Server Port: Set the access point of the system.
DNS: Set a DNS address of the server.

Clear Data in the Device when Adding: If this option is selected, then after adding a device, the system
will clear all data in the device (except the event logs). If you add the device merely for demonstration or

testing, there is no need to select it.
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&Note: When using either of the above three device adding methods, if there exists a residual data in the
original device, please sync the original data to it after adding a new device to the software by clicking

Device > Synchronize All Data to Devices, otherwise, these original data may conflict with normal
usage.

The current query conditions MNone

C’ Rzfresh ‘% Mew ﬁf]\ Delele I—_l’ Export O\ Search Device ="'l:£!“= Device Control - {Ju\} Setup - @ View and Cet Device Info  ~ ﬁ Communication -~
- Device, 2. Cl'“:k on Device COI'Itl'Ol. {n—mrr (! CIearAdmfnlstratorpen‘nlssmn RS485 Status Dievice Register  Firmware Version
weme—" Type 1, Upgrace Fimuare Parameter Model Device
[£% Reboot Device
! 192168 21367 CGFE184760043  Area Name HTTF =1 Synchronize Time Online SpeedFace-V: @ 1.0.55
ing oY
~/ Enable
1. Select the required device @ Disable

?j Synchronize All Dala o Devices

™ 3. Click here
A —

The default IP address of the access device may conflict with the IP of a device on the local network.
You can modify its IP address: click Modify IP Address, and a dialog box will pop up in the
interface. Enter the new IP address and other parameters (Note: Configure the gateway and IP
address in the same network segment).

&Note: Some PUSH devices support SSL. To use this function, select the HTTPS port during software
installation and ensure that the device firmware supports SSL.
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I/O Board

On the device module, click Device > I/0 Board > New to add the I/0 Board device to the software.

Disvice Name | AmaName B Qa ®
The cumrent query conditions None

Name Area Name. Chwned Device Number 10 Board Type. RS485 Address  Operations
Dowr
Readar
AuiBary Input
New
Nama™ |
Diavice Name® Click 10 selact
"G Boaid Type™

RES485 Address”

RE485 Agdrese Code Figura

Enter the name of the 1/0 Board. Select the Device by clicking the Device Name field. The device list
appears, as shown below:

Device Name |:| Serial Number Q ®
The current query conditions Mone
Alternative Selected(D)
Device Name Serial Mumber Device Name Serial Number
=
=
0 50 rows perpage ~  Total of 0 records

Cancel

Select the device and click OK. Select the I/0 Board Type. Set the RS485 Code Address by changing the
corresponding button. Click OK to save the details. You can view all the auxiliary inputs in the Auxiliary
Input interface.

Note: Please select this method when adding DM10 and AUX485.
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Device Operation

For the communication between the system and device, data uploading, configuration downloading,
device, and system parameters shall be set. Users can edit the access controllers within the appropriate
levels in the current system; users can only add or delete devices in Device Management if needed.

(_*+ Rafresh |@ New ﬁ]‘ Delete B Export O Search Device =, Device Control = @ Selup = [a View end Get Device Info = & Communication ~

i Clear Administrator permission

pv Device Nams Serial Number Area Communic ~— -85 Status Davice Register Frmwars Cperations
Name Type L. Upgrace Fimmware amatar Mads! Device  Version
r__: Rebool Device
v SpeedFace-y'5 CGFE1B4TA0043  Area Mame HTTP r"l Synchranize Time Ciffiina SpeedFace-\: & 1055 Edil Delafa
/' Enable

@) Disable

':;"“ Synchronize All Data to Devices

[+ Refresh | New [ Delete [ Expot Q) Search Device 5. Device Control = 485 Setup. = [ View and GelDevice Info ~ & Communication ~
LH Set Davice Time Zona

W Device Name Serial Number Area Communic:  Network 1P A eqgister  Fimware Cperations
Name Type Connection & Sel a5 Registration Device avice Varsion
Med :
i 2%, Set Daylight Saving Time
~  SpeadFace V5 CGFE184780043  Area Name HTTP Wired 192137 Modify the Fingerprint Identification Threshold 1.055 Edit Delate

A% Set Davice In/Out State

L:'- Reafresh r_'&? New ﬁ‘" Delete E Exporl Q Search Device __E._ Device Control ~ {é}Sﬁim = @Wﬁwdealeanfo - Q Commumication -~
09 Get Device Option

~ Device Name Serial Number Area Communicc  Network IP Address RS54 Register Famware Operations
Name Type Connection Parz (- Get Personnel Information  Device  Version
N
e [T Get Transactions
~  SpeedFace-vi CGFE1B4760043  Area Name HTTP Wired 192.168.213 67 -i. View Rules of Devices L] 1.0.55 Edii Dalels

oy View Device Capacity

|\_'- Refrash ENB‘W Eﬁﬁ Deleta |—_|’ Export Q Search Davice _.E.E Device Confrol = @ Setup = @Vﬂ;m and Get Device Info. = @Cornmunicaunn -

1 Modify IP Address

v Device Name Serial Number Area Communic:  Metwork IF* Address RS5485 Status  Device ) L
Nama Type Connaction Paramater MModal = Modify Communication Password
Mode: 5 Switch Network Gonnaction
~  SpeedfaceVs CGFE1B4760043  Area Mame HTTP Wired 19216821367 Cfine SpesdFace-V. @ 1055 Edit Dalate

Edit or Delete a Device

Edit: Click the Device Name or click Edit to access the edit interface.

Delete: Select the device, click Delete, and click OK to delete the device.
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Edit
Device Name™ |EpeedFace—\r'5
Communication Type® TCP/IP & HTTP
Senal Number" CGFE184760043
IP Address™ 192 . 68 23 B
Communication port” 6665
lcon Type® Doaor
Control Panel Type
Area” | Area Name
Set Wiegand Reader Click 1o select the reader ®
A\ [Clear Data in the Device whan Adding] will delete data in the device (except event
record), please use with caution!

For further details and settings of the above parameters, see Device. Some details cannot be edited. The
device Name should be unique and must not be identical to another device.
Control Panel Type cannot be modified. If the type is wrong, users need to delete the device and add it

again manually.

Export

Device information can be exported in EXCEL, PDF, and CSV file formats.

Export
The File Type EXCEL File v
Export Mode # All data (export up to 30000 pieces of data)

Selec! data volume export (export up 1o 30000 piaces of data)

From the article 1 Sirip, is derived 100 Data

.

Device
Deviee Name Serial Number | Arca Name|Com munic Network IP Address RS485 Status Device Register Firmware Version
ation Type | Connection Paranmeter Model Deviee
Mode
SpeedFace-V5 CGFEIB4TE0043 | Area Name| HTTP Wired 192 168.213.67 Offline | SpeedFace- Yes L0565
V&

Disable/Enable

Select a device, click Disable/ Enable to stop/ start using the device. When the communication between
the device and the system is interrupted, or the device fails, the device may automatically appear in
disabled status. After adjusting the local network or device, click Enable to reconnect the device and

restore device communication.
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The current query conditions MNone

(% Refresh  [® New [fp Delete [# Expot Q Search Device 2, Device Control ~ 4% Setup ~

g i e Clear Administrator permission
2. Click on Device Control e

~Name—" Type .1, Upgrade Firmware

Reboot Device

W Device,

v SpeedFace V5 CGFE1847650043  Area Name HTTP ‘{Ej , Synchronize Time
N "~/ Enable
1. Select the required device (&) ok
‘72 Synchronize All Data to Devices

3. Click as required

Synchronize All Data to Devices

To synchronize data of the system to the device, select the device and click Synchronize All Data to
Devices and click OK to complete synchronization.

The cument query conditions Mone

("% Refiesh B New ﬁ Dekste 3 Expord Q Search Device ;2‘: Device Conlrol = {9} Selup = La View end Gef Device Info. ~ E Gommunication =

" 3 — v
A Device i 2. Click on Device Control ’Egrmr ] Clear P.dmfmsiratul et F5483 Status Device Model Fegister  Firmware Version
- BT Type [t Upgrace Firmware Farameler Dievica
Feboot Device
~  SpeedFace Vi CGFE1B4TA0043  Area Name HTTP [33" synchronize Tima Onlne  SpeedFace-v5 -] 1.0.55
b & /' Enablz
1. Select the required device _ (D) Disavle

[ Synchronize All Data to Devices

™ 3. Click here

—
Synchironize All Data lo Davices
SelectedDeviee
(s Standalone Device - SpeadFace-V5
¥ Access Authority « TimeZone, holidays #| Multi-Person Open Door
Clear All
¥ First-Person Open Door
Total Progress

[ isan

& Note: Synchronize All Data to Devices will delete all the data in the device first (except transactions),
and thus download all settings again. Please keep the internet connection stable and avoid power down
situations. If the device is working normally, please use this function with caution. Execute it in rare user
situations to prevent impact on the regular use of the device.

Page |36 Copyright©2020 ZKTECO CO,, LTD.  All rights reserved.



(C2-260/inBio2-260 Access Control Panel User Manual

Upgrade Firmware

Select the required device that needs to be upgraded, click Upgrade firmware to enter the edit interface,
then click Choose File to select the firmware upgrade file (named emfw.cfg) provided by the Access
software, and click OK to start upgrading.

‘Upgrade Firmware

Selected Device{Can only upgrade equipment of the same type)
® SpeedFace-V5 : SpeedFace V5

Select File| Choose File | Mo file chosen

[Total Progress

en

&Note: The user shall not upgrade firmware without authorization. Contact the distributor before
upgrading the firmware or upgrade it by following the instructions of the distributor. The unauthorized
upgrade may affect normal operations.

Reboot Device

It will reboot the selected device.

Synchronize Time

It will synchronize the device time with the server’s current time.

Set Device Time Zone

If the device supports the time zone settings and is not in the same time zone with the server, you need to
set the time zone of the device. After setting the time zone, the device will automatically synchronize the
time according to the time zone and server time.

Set as Registration device

Set the registration device only when the standalone device’s data such as personnel can automatically
upload.
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SRIEE RAIEIREII MEEE

Sst as Reqistration Device Yes

Set Daylight Saving Time

According to the requirements of different regions, set the Daylight-Saving Time rules.

Modify the fingerprint identification threshold (Ensure that the access controller supports

fingerprint function)

Modify the Fingerprint Identification Threshoid

The fingerprint identification threshold® |735-?n:

Set Device In/Out State

It will define the condition of the master device as Entry or Exit.
Set Device In/Out State

Master device state Entry v

Cut

Get Device Option

It gets the common parameters of the device. For example, it gets the firmware version after the device is
updated.
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Get Personnel Information

It displays the current number of personnel, fingerprints, finger vein, and face templates in the device. The
final value will be displayed in the device list.

Get Personnel Information

Selected Device
(#) SpeedFace-V5 : SpeadFace V5 |

You can choose the required option |

@ Obtain personnel information _iDbtain fingerprint information
i1 Obtain Face Picture Information

|| Get count only

Total Progress

Get Transactions

It fetches the transactions from the device into the system. Two options are provided for this operation:
Get New Transactions and Get All Transactions.

Get New Transactions: The system only gets new transactions since the last collected and recorded
transaction. Repeated transactions will not be rewritten.

Get All Transactions: The system will get transactions again. Repeated entries will not be shown twice.

When the network status is healthy, and the communication between the system and device is normal,
the system will acquire the transactions of the device in real-time and save them into the system database.
However, when the network is interrupted, or communication is interrupted for any reason, and the
transactions of the device have not been uploaded into the system in real-time, Get Transactions can be
used to acquire transactions of the device manually. Besides, the system, by default, will automatically
acquire transactions of the device at 00:00 on each day.

& Note: An Access controller can store up to 100 thousand transactions. When transactions exceed this
number, the device will automatically delete the oldest stored transactions (deletes 10 thousand
transactions by default).
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View Rules of Devices

Shows the Access rules in the device.

View Rules of Devices \

Rule Type Description Rules Detaits

Firsi-Person Normally Open Not Set [Nane i ‘
Multi-Person Cpeaning Doar Mot Sat |
Dioor Sensar Mot Seat |
Active Time Zonge Has been sei i
Passage Mode Time Zone Mot Sat

Between multiple niles

with & '|' separated

View Device Capacity

It displays the capacity of personnel’s biometric details in the device.

o Do orecty 3

In Software In Firm\Ware |
~ 1 -~ - Q - |
o @ ! v & é i - GetAl
SpeedFace-Vs 510000 010000 X 116000 Gel ‘
Ak 11 vou find that the data s not consistent with the device, please synchronize the data of devices before trying again
Cancel

Modify IP Address

Select a device and click [Modify IP address] to open the modification interface. It will obtain a real-time
network gateway and subnet mask from the device. (Failed to do so, you cannot modify the IP address).
Then enter a new IP address, gateway, and subnet mask. Click OK to save and quit. This function is similar
to [Modify IP Address Function] in Device.
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Modify Communication Password

The system will ask for the old communication password before modifying it. After verification, enter the

new password twice and click OK to alter the communication password.

& Note: A Password should be a combination of numbers and letters of 6 digits.

Users can modify the fingerprint identification thresholds in the devices; it ranges from 35 to 70, and it is

55 by default. The system will read the thresholds from the device. Users can view the threshold devices

list. More than one device can be changed by using the Batch operation function.

Add a user and a card

Click Personnel Management > Personnel > New.

Personnel ID*

First Name

Gender

Certificate Type

Birthday

Device Verification Password

Biclogical Template Quantity

Access Control

Levels Setiings
¥ General

Fields are as follows:

New

Department’

w

Last Name
e Mobile Phone
A Certificate Number
Email

Card Number

Time Attendance Personnel Detail

Superuser

Device Operation Role
Disabled

Set Valid Time

Depariment Name

Browse Capture

No

Crdinary User

(oo e |0 Jcaa |

Personnel ID: An ID may consist of up to 9 characters, within the range of 1 to 79999999. It can be

configured based on your requirements. The Personnel ID contains only numbers by default but may also

include letters.

= Notes:

When configuring a personnel number, check whether the current device supports the

maximum length and whether letters can be used in Personnel ID.
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To edit the settings of the maximum number of characters of each personnel number and
whether letters can also be used, click Personnel > Parameters.

Department: Select from the drop-down menu and click OK. If the department was not set previously,
only one department named Company Name would appear.

First Name/Last Name: The maximum number of characters is 50.

Gender: Set the gender of personnel.

Mobile Phone: Enter the phone number of the user.

Certificate Type: There are four types of certificates: ID, Passport, Driver's License, and others.
Certificate Number: Enter the Certificate number.

Birthday: Enter the employee's Date of Birth.

Email: Enter the employee’s Email ID. The max length is 30 characters.

Device Verification Password: Set the password for verifying with the device using personnel accounts.
It can only contain up to 6-digits. It cannot be the same with other user’s password and the duress
password.

Card number: The max length is 10, and it should not be repeated.

Personal Photo: The picture preview function is provided, supporting common picture formats, such as
JPG, JPEG, BMP, PNG, GIF, etc. The best size is 120x140 pixels.

Browse: Click Browse to select a photo on your local drive to upload.
Capture: Taking a photo by a camera is allowed when the server is connected with a camera.

Register Fingerprint / Finger Vein: Enroll the Personnel Fingerprint, Finger Vein, Palm, or Face. To trigger
the alarm and send the signal to the system, scan the Duress Fingerprint.

How to register fingerprint:
Biological Template Quantity Ggo@o E 0 & -DE 0

Access Control ﬁ Personnel
Move the cursor to the fingerprint icon position, a registration pop-up or driver download dialog
box will appear, click Register.
Select a fingerprint, press the finger on the sensor continuously until the message “Fingerprint
registered Successfully” is prompted.
Click OK to complete the registration.
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Fingerprint Fingerprint
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Click a fingerprint to delete. If you need to register a duress fingerprint, select the Duress Fingerprint

checkbox.

& Notes:

If fingerprints are duplicated, “Don’t repeat the fingerprint entry” will be prompted.
If the fingerprint sensor driver is not installed, click “Install driver” and the system will prompt to
download and install the driver.
After installing the fingerprint sensor driver, if the fingerprint register button is grey in IE
browser while it is normal in other browsers (such as Firefox, Google), you can change the
settings of IE browser, as per the following:
In Internet Explorer, click Tools > Internet Options > Security > Credible Sites, add
http://localhost to the credible sites, then restart the Internet Explorer.
In Internet Explorer, click Tools > Internet Options > Advanced > Reset to pop up a dialog
of Reset Internet Explorer Settings, click Reset to confirm, then restart the Internet Explorer
(you may try when Point 1 does not help).
If all the above settings do not work, please execute the following operations (take IE11
browser as an example): click Tools > Internet Options > Advanced > Security, check the
option [Allow the software to run or install even if the signature is ..], and remove the
selection of [Check for server certificate revocation], then restart IE.
If the browser version is below IE8, the fingerprint registration page will be different:
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Fingerprint Fingerprint
Scans Left:3

The finger information:

Right Hand
Forefinger

Click the checkbox to register or delete fingerprint.

i = W =

The system supports access from the Live20R fingerprint device and the fake fingerprint
prevention function.

The finger Information:

Right Hand
Middie Finged

=

2. To set the Access Control parameters for the personnel, click Access Control
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Access Control Time Attendance Personnel Detail
Levels Settings Add Superuser No
#| General Select All i " "
Unselect Al Device Operation Role Ordinary User

Disabled

Set Valid Time

Cooeoonen J o | cower |

Fields are as follows:

Level Settings: Click Add, then set the passage rules of particular positions in different time zone.

i Al b |-ocls:
i
| |
! Laval Mama | | TemaZona Q @
i The current query conditions Mane
_l Albeiraenes Solaciedll]
| L e Mama Tima fana Lt Hema Trma Fana
|
} -

=

s

f 50 mows. e page =
Cancel

Superuser: In the access controller operation, a superuser is not restricted by the regulations on time
zones and has extremely high door-opening priority.

Device Operation Role: It will define the authority level in the device of the user.
Disabled: Temporarily disables the personnel’s access level.

Set Valid Time: Doors can be set to open only within specific periods. If the checkbox is not selected, the

door is always open.

& Note: The system will automatically search for the relevant numbers in the departure library during

verification.

The Personnel Information List, by default, is displayed as a table. If Graphic Display is selected, photos
and numbers will be shown. Place the cursor on a photo to view the details about the personnel.
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& Notes:

Not all devices support the “Disabled” function. When a user adds a device, the system will notify
the user whether the current device supports this function or not. Please upgrade the device to

use this function.

Not all the devices support the “Set Valid Time” function. Some devices only allow the users to
set the year, month, and day of the local time. When a user adds a device, the system will notify
the user whether the current device supports this function or not. Please upgrade the device to

use this function.

Click Personnel Detail to access the details and editing interface and enter the information.

Access Control Time Attendance Personnel Detail

Employee Type v
Job Title

Birthplace

Home Phone

Office Phone

Hire Type v
Street

Country

Home Address

Office Address

After entering the information, click OK to save and exit, the personal details will be displayed in

the added list.

Access Control Settings

The Access Control system can set the access levels of the registered users, namely, allowing some

personnel to open some doors by verification during a period. Access Control System Management

primarily includes Access Control Time Zones, Access Control Holiday, Door Settings, Access Levels,

Personnel Access Levels, Real-Time Monitoring, and Reports, etc.

Access control system parameters

255 time zones.
Unlimited access levels.

Three-holiday types and 96 holidays in total.

Anti-passback function.
Multi-Card Opening function.
Real-time monitoring.

Interlock function.

Linkage function.

First-Card Normal Open function.
Reader Settings.

Auxiliary I/O Settings.

For more details, please refer to “ZKBioAccess User Manual.”

Real-time monitoring

Click Access Device > Real-Time Monitoring.
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It monitors the status and real-time events of doors configured to the access control panels in the system
in real-time, including normal events and abnormal events (including alarm events).

The Real-Time Monitoring interface is shown as follows:

Device blocked - Door Offline

i K

Door sensor not set; relay closed E Door sensor not set; relay opened

Door sensor not set, and the current firmware does not support the current action on the

device

Online status Door closed; Relay closed Online status Door closed; Relay opened

Online status Door closed, and the current firmware does not support the current action on
the device

Online status Door opened; Relay

Online status Door opened; Relay closed .
opened

Online status Door opened, and the current firmware does not support the current action on
the device

Door opened alarm; Relay closed Door opened alarm; Relay opened

Door opening timeout, Relay closed Door opening timeout, Relay opened

.‘.

Door opening timeout and the current firmware does not support the current action on the

device
.®  Door opening timeout, Relay closed/Door L2  Door opening timeout, Relay opened/
®  Sensor Closed “  Door Sensor Closed
o
: Door closed alarm; Relay closed . Door closed alarm; Relay opened

@  Door closed alarm, indicates that the current firmware does not support the current action on

the device
Eﬂ Door sensor not set, Door alarm, Relay ﬁ Door sensor unset, Door alarm, Relay
“  closed “  opened
®  Door opening timeout, without relay E& Door lock

status/Door Sensor Closed

Without relay status, it indicates that the current firmware does not support the action on the device.
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Arza Status e Device Mame | Sarlal Number
Do Auxliary Inpul Awgliary Quiput
AllDoors. | | Remote Opening || Remole Closing  ICa# Cancel Alam [ Remole Nommally Open = More ~

N i

SpeedFace- 1562168213 192 168213
V51 23-1 -2

Current Totak3 @ Online:3 @ Disable.0 @ Offlme:d & Unknown.0 Door Name

Real-Time Events

Tims Area Device Ewvent Paint Ewvant Description Card Number Personnel Reader Name Verification Mode
2MB-12-27 174046 Area Name 192160 213.99{3633160600001) Dewice Started Olher Other
2018-12-237 174516 Area Name 192.168.213.09(3633160800001) Device Started Oihar Other
2MB-12-2T 174324 Area Name 182 160 213 95363 3160800001) ad 10 the server Othar Othar
2018-12-27 174306 Area Nama 192 168 213 95{3833160800001) Other Other
2018-12-27 174301 Area Name  SpeedFace-VS{CEFE184T760043) SpeedFace-V5-1 Marmal Verify Open 575{Jefl SpeedFace-V5-1-Oul Face
2018-12-27 174253 Area Name SpeedFace-VS{CGFE184T60043) SpeedFace-V5-1 Normal Verify Gpan S575(Jaily SpeedFaceV5-1-0ul Face
Total Receved: & w Normals o Exception:0 @Alarm:0 Clear Data Rows Ewvent Description B B Showf’notos

Different icons represent the status as follows:
Door

Remote Opening/Closing: It can control one door or all the doors.

To control a single door, right-click on it, and click Remote Opening/ Closing in the pop-up window. To
manage all entries, directly click Remote Opening/ Closing in Current All option.

In the remote opening, the user can define the door opening duration (The default is 15s). You can select
[Enable Intraday Passage Mode Time Zone] to enable the intraday door passage mode time zones or
set the door to Normal Open, and then the door will not be limited to any time zones (can be opened at
any time).

To close a door, select [Disable Intraday Passage Mode Time Zone] first, to avoid enabling other normal
open time zones to open the door, and then select [Remote Closing].

& Note: If [Remote Opening /Closing] fails, check whether the devices are disconnected or not. If
disconnected, check the network connectivity.

Cancel the alarm: Once an alarming door pops-up over the interface, the alarm sound will be played.
Alarm cancellation can be made for a single door and all the entries. To control a single door, move the
cursor over the door icon, a menu will pop-up, then click Remote Opening/ Closing on the menu. To
manage all the doors, directly click Remote Opening/ Closing in Current All option.

&5 Note: If Cancel the alarm fails, check if any devices are disconnected. If found disconnected, check the
network.

Remote Normally Open: It will set the device as normal open by remote.
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Quick Management of Doors

If you move the cursor over a door’s icon, you can quickly perform the above-explained operations.

Besides, you can query the latest events from the door.

E Status

192,168
‘99 Device: 192.168.213.99

Serial Number: 3633160800001
Number: 2

Door Sensor: - No Door Sensor
Relay: Close

Alarm: None

Remote Opening

Remote Closing

Cancel Alarm

@0
Remote Normally Open

Enable Intraday Passage Mode Time Zone

Disable Intraday Passage Mode Time Zone

rea Query the latest events from the door N

Query the latest events from the door: Click to view the current events on the door quickly.

Issue card to a person: If you swap an unregistered card, a record with a card number will pop-up in a
real-time monitoring interface. Right-click that card number, and a menu will pop-out. Click “Issue card to

person,” to assign that card to one person.

Multiple selections

You can select several doors at the same time to perform operations such as remote opening, remote

closing, canceling alarm, etc. Double-click the door icon to edit the door properties.

Arez Stafus ————v Device Name Mors = @
Daor Auxiliary Input Auxiliary Output
; - i - 3 & 4= T = b
Al Deors Remote Dp=ng Remots Clos.ig  IG# Cancel Aorm == Remole Norlally Open = More -
= ol || ol
192 168.0 192 168.10| (192168 10| |192.1681
105-1 2321 2191 | T
1
Current Total 4 @ Onhned o Disable:d @ Offlinecd @ Unknown.0 Door Name

Event monitoring

The system will automatically acquire the records of devices being monitored (by default, it displays 200
records), including normal and abnormal access control events (including alarm events). Normal events

will appear in green; alarm events will appear in red; other abnormal events will appear in orange.
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Auxiliary Input

It monitors the current auxiliary input events in real-time.

Area Slatus —_— Davice Name Serial Number
Door Auxiliary Input Auxiliary Cutput
o o
Auweiliary Auxiliary
Input-1 Input-2
Current Total 2 @ Online ¢t @ Disabled @ Offine 2 & Unknown 0 Auxiliary Input Name
Real-Time Events
Time Area Device Event Point Eveni Descriplion Card Number Personnel Reader Name Verification Mode
Auxiliary Output

Here you can perform Remote open, Remote Close, Remote Normally Open functions.

Area Status Dievice Name Serial Number
Door Auxlliary Input Auxiliary Output
All Doors ™) Remote Open Remote Close " Remote Normally Open
- ~
Awdliary Auxiliary
Output-1 Output-2
Current Total:2 @ Online:0 @ Disable:0 @ Offfine:2 & Unknown:0 Auxihary Cutput Name
Real-Time Events
Time Area Device Event Pont Event Descrnphion Card Number Personnel Reader Neme Venfication Made

Reports

Since the data quantity of access control event control is large, you can view the specific access control
events through query conditions. By default, the system displays the
last three months' transactions. Click [Reports] > [All Transactions]

to view all the transactions.
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Q) Tho tma from 20180027 000000 To 20181227 235059 Pessonnel D I Davica Name Moo Q@
— The current query conditions The time from:(2018-09-27 0000007 To(2018-12-27 23 50:59)
] Device
- (% Refresh G5 Cloar A8 Data [ # Export
Access Control " ;. - |
Evend ID Time Device Nama Evont Pont Evont Description M File Parsonnel 1D First Namo Las! Name  Card Number Dopardmen  Deps
Murnber Nam
' Regiorts
2018-12.27 191548 SpesdFace-V3 Disconnecled =
2018-12-27 175730 192 168 213.99 Disconnecied
Evenls From Today 84378 2018-12-27 17.58:04 102.168.213.00 Device Started
64375 2018-12-27 1T 4846 192 168213 69 Device Started
{nown Posifion
64374 2018-12-27 17,4516 19216821309 Device Started
RSO 64371 20181227 174324 192 16821200 Cannectad to the sen
Access Rights By Door 44372 2018-12-27 174306 192.168.213.09 Device Started
Access Rights By Parsonnel 2018-12-27 174301 Spesdface-Vs Speecfeca-Vs-1 Hormail Venty Open 575 Jett 1 i)
2018-12-27 174253 SpeedFace-Vs SpeedFace-V5-1 Normal Verdy Open 575 Jufl 1 2k
20M8-12-27 172529 19216821399 Disconnecied
44371 20181227 1356408 192168.213.99 Connecled to he serv
84370 2018-12-27 135601 192.168.213 63 Device Stared
2018-12-27 11 46.40  Spsedface V3 SpeedFaca-vi-1 Normat Verdy Open 575 Jeff 1 Zt

Media File: You can view or download the photos and videos.

Clear All Data: This function is used to clear all the transactions. Click [Clear All Data]. In the appearing

pop-up, click OK to remove all the transactions.

Export: You can export all the transactions in Excel, PDF, and CSV format.
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All Transactions
Event Time Device Name| Event Point Event Personnel | First Name | Last Card Depart | Depariment| Reader | Verification| Area | Rem
1D Description 1D Name | Number ment Name Name Mode Name | ark
Numbe
I
| 2018-12-27 SpeedFace Disconnected QOther Other Area
19.15:48 V5 Name
-1 2018-12-27 |192.1682139 Disconnected Other Other Area
17:57:30 9 Niamé
64376 2018-12-27 |192.168.213.9 Device Staried O ther Other Area
17:56:04 4 Name
64475 2018-12-27 [192.168.213.9 Device Started Other O ther Area
17:48:46 g Name
61374 2018-12-27 |192.168.213.9 Device Started Other Other Aren
17:45:16 4 Name
64373 | 2018-12-27 |192.168.213.9 Other Other Aren
17:43:24 9 Name
64372 | 2018-12-27 |192.168.2139 Other Other Aren
17:43:06 9 Name
1255 SpeedFace- |SpeedFace-V5-| Normal Verify 575 Jeff 1 ZKTeco |SpeedFace- Face Area
Va Open Vo-1-Out Nime
1254 SpeedFace- |SpeedFace-V5-| Normal Verify 575 Jell 1 ZKTeco |SpeedFace- Face Area
¥h 1 Open Vo1-Out Name
-1 192.168.213.9 Disconnected Other Other Area
b &
64371 192 168.213.9 Connected 10 Other O ther a
4 the server Name
4370 2018-12-2 192.168.213.9 Device Started Other (O ther Area
13:56:01 4 Nome
1253 SpeedFace- |SpeedFace-V5-| Normal Verily 575 Jefl 1 ZKTeco | SpeedFace- Face Area
Ve 1 Nenn VE - Alsonn
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Statement on the Right to Privacy

Dear Customers,

Thank you for choosing this hybrid biometric recognition product, which was designed and
manufactured by ZKTeco. As a world-renowned provider of core biometric recognition technologies, we
are constantly developing and researching new products, and strive to follow the privacy laws of each
country in which our products are sold.

We Declare That

All our civilian fingerprint recognition devices capture only characteristics, not fingerprint images, and
do not involve privacy protection.

None of the fingerprint characteristics that we capture can be used to reconstruct an image of the
original fingerprint and do not involve privacy protection.

As the provider of this device, we will assume no direct or indirect responsibility for any consequences
that may result from your use of this device.

If you would like to dispute human rights or privacy issues concerning your use of our product, please
directly contact your dealer.

Our other law-enforcement fingerprint devices or development tools can capture the original images of
citizen's fingerprints. As to whether or not this constitutes an infringement of your rights, please contact
your Government or the final supplier of the device. As the manufacturer of the device, we will assume no
legal liability.

Note:

The Chinese law includes the following provisions on the personal freedom of its citizens:
There shall be noillegal arrest, detention, search, or infringement of persons.
Personal dignity is related to personal freedom and shall not be infringed upon.

A citizen's house may not be infringed upon.

A citizen's right to communication and the confidentiality of that communication is protected by the

law.

As a final point, we would like to further emphasize that biometric recognition is an advanced technology
that will be certainly used in E-commerce, banking, insurance, judicial, and other sectors in the future.
Every year the world is subjected to major losses due to the insecure nature of passwords. The Biometric
products serve to protect your identity in high-security environments.

Page |52 Copyright©2020 ZKTECO CO,, LTD.  All rights reserved.



(C2-260/inBio2-260 Access Control Panel User Manual

Eco-friendly Operation

fl:?-[‘- The product's "eco-friendly operational period" refers to the time period during which this
L'y
d product will not discharge any toxic or hazardous substances when used in accordance

with the prerequisites in this manual.

The eco-friendly operational period specified for this product does not include batteries or
other components that are easily worn down, and must be periodically replaced. The
battery's eco-friendly operational period is 5 years.

Hazardous or Toxic substances and their quantities

Hazardous/Toxic Substance/Element

Component . Hexavalent | Polybrominate | Polybrominated
Name Mercury | Cadmiu . . ]

Lead (Pb) (Ha) d) chromium d Biphenyls Diphenyl Ethers

m
d (Cr6+) (PBB) (PBDE)
Chip Resistor X o o o o o
Chip Capacitor X o o e o o
Chip Inductor X o o o o o
Diode X [ o o o o
ESD
X O O O O (@]

component
Buzzer X o o o o o
Adapter X o o e o o
Screws o © © X o o

o indicates that the total amount of toxic content in all the homogeneous materials is below the
limit as specified in SJ/T 11363—2006.

X indicates that the total amount of toxic content in all the homogeneous materials exceeds the limit
as specified in SJ/T 11363—2006.

Note: 80% of this product’s components are manufactured using non-toxic and eco-friendly
materials. The components which contain toxins or harmful elements are included due to the
current economic or technical limitations which prevent their replacement with non-toxic materials
or elements.
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